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PLEASE NOTE

COPYRIGHT This document refers to proprietary computer software which is pro-
tected by copyright. All rights are reserved. Copying or other repro-
duction of this manual or the related programs is prohibited without 
prior written consent of DHI A/S (hereinafter referred to as “DHI”). 
For details please refer to your 'DHI Software Licence Agreement'.

LIMITED LIABILITY The liability of DHI is limited as specified in your DHI Software 
Licence Agreement:

In no event shall DHI or its representatives (agents and suppliers) 
be liable for any damages whatsoever including, without limitation, 
special, indirect, incidental or consequential damages or damages 
for loss of business profits or savings, business interruption, loss of 
business information or other pecuniary loss arising in connection 
with the Agreement, e.g. out of Licensee's use of or the inability to 
use the Software, even if DHI has been advised of the possibility of 
such damages. 

This limitation shall apply to claims of personal injury to the extent 
permitted by law. Some jurisdictions do not allow the exclusion or 
limitation of liability for consequential, special, indirect, incidental 
damages and, accordingly, some portions of these limitations may 
not apply. 

Notwithstanding the above, DHI's total liability (whether in contract, 
tort, including negligence, or otherwise) under or in connection with 
the Agreement shall in aggregate during the term not exceed the 
lesser of EUR 10.000 or the fees paid by Licensee under the Agree-
ment during the 12 months' period previous to the event giving rise 
to a claim.

Licensee acknowledge that the liability limitations and exclusions 
set out in the Agreement reflect the allocation of risk negotiated and 
agreed by the parties and that DHI would not enter into the Agree-
ment without these limitations and exclusions on its liability. These 
limitations and exclusions will apply notwithstanding any failure of 
essential purpose of any limited remedy.
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Introduction
1 Basic Geodesy

Geodesy is the branch of science concerned with the determination of the 
size and shape of the earth. This section will in the following discuss the fol-
lowing aspects of geodesy:

1. Geoid

2. Ellipsoid

3. Datum

4. Map Projection

5. Datum Transformation

1.1 Introduction

As the earth is an almost spherical object, mathematical methods have been 
developed by cartographers to project the curved surface of the earth to the 
flat surface of a map. These methods, known as map projections involve the 
concept of wrapping an imaginary cylinder or cone around an ellipsoid model 
of the geoid, and then projecting from the ellipsoid model to a cylinder or 
cone. Cylinders and cones are called developable surfaces because they can 
be cut and placed on a flat surface, such as a map, without distorting the pro-
jected features.

Figure 1.1 Mapping of the world onto plane coordinates

1.2 Geoid

The geoid is an invisible, continuous closed surface and is an equipotential 
surface or a level surface. It is a surface at which the potential of gravity is 
constant and the vector sum of the force of gravity and centrifugal force due 
to the rotation of the earth is normal to the surface at every point. A level sur-
face undulates over a geographic area due to variations in the mass of the 
earth's terrain and seas. A level surface is chosen that, on average, coincides 
with the surface of the oceans. This surface is called the geoid. As a result, 
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Basic Geodesy
the geoid is often defined as the mean sea level. The geoid undulates even in 
areas of the earth where there are oceans, because the mass and density of 
the water and rock beneath the ocean are not constant.

Figure 1.2 Definition of geoid, ellipsoid and the earth surface

1.3 Ellipsoid

The ellipsoid is a three-dimensional model formed by rotating an ellipse about 
its minor axis. An ellipsoid, sometimes called a spheroid, is used as the refer-
ence system of the geoid instead of a sphere because the earth is slightly 
flattened. The earth's polar axis is shorter than the diameter of the earth 
measured at the equator. An ellipsoid serves two purposes. It serves as a ref-
erence system for creating the geoid model, and it serves as a mathematical 
model for locating the earth's features geographically. The earth's features 
are projected from the earth's surface to the ellipsoid. 

An ellipsoid is uniformly defined through two parameters: 
8 MIKE Zero Geodesy - © DHI A/S



Ellipsoid
1. a semi-major axis (a)

2. a semi-minor axis (b)

The inverse flatness parameter is found by eq. (1.1).

(1.1)

Figure 1.3 Outline of Ellipsoid

From the ellipsoid they are geometrically projected to a map, or their geo-
graphic locations on the map are mathematically computed in some manner. 
There are many mathematical algorithms for transferring features from the 
ellipsoid to the map. Figure 1.4 show the geographical position of point P 
described by various parameters related to an ellipsoid.

a
a b–
------------
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Basic Geodesy
Figure 1.4 Geographical coordinates 

1.4 Datum

1.4.1 Geodetic datum

A geocentric coordinate system has its origin at the centre of the earth, with 
the x axis and y axis in the equatorial plane, with the x axis passing through 
the prime meridian, and with the z axis along the polar axis. The production of 
a new ellipsoid and its geocentric and geodetic coordinate systems is called a 
geodetic datum. Maps using the new geodetic datum will have their features 
shifted geographically relative to the old datum. Differences between different 
datums are illustrated in Figure 1.5. 
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Map Projection
Figure 1.5 Position shifts for a point using different geodetic datums

1.4.2 Vertical Datum

A vertical datum is a network of benchmarks whose elevations (orthometric 
heights) have been measured and adjusted simultaneously relative to mean 
sea level (the geoid). 

Vertical datums are independent of horizontal datums (i.e. geodetic datums).

1.5 Map Projection

A projection is a mathematical expression for the curved surface of an ellip-
soid on a rectangular coordinate grid. Distortions of the Map characteristics 
(conformality, distance, direction, scale, and area) always result from a map 
projection. 

1.5.1 Types of projection

Some projections minimize distortions in some of the Map characteristics at 
the expense of maximizing errors in others. Some projections are attempts to 
only moderately distort all of these characteristics.
Powering Water Decisions 11



Basic Geodesy
Cone

In normal aspect, the cone is placed tangent to the globe along a parallel of 
latitude or secant to the globe, intersecting the globe along two parallels. 
Meridians are represented as straight lines radiating from the apex of the 
cone and parallels of latitude are represented as concentric circular arcs. The 
standard parallel(s) is/are true to scale. 

Figure 1.6 Map projection: Cone

Distortion is minimized in a narrow band along the standard parallel(s) and 
increases with distance from the standard parallel(s).

Figure 1.7 Pattern of distortion

Cylinder

The normal aspect for cylindrical projections assumes that the cylinder is tan-
gent to the globe along the Equator. In this orientation, the graticule appears 
as a rectangular grid. Meridians of longitude are straight lines, equally spaced 
along, and perpendicular to the Equator. Parallels of latitude are represented 
as straight line parallel to and having the same length as the Equator.
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Map Projection
Figure 1.8 Map projection: cylinder

In the tangent case, the Equator is true to scale and distortion increases with 
distance from the Equator. In the secant case, the standard parallels which lie 
equidistant north and south of the Equator are true to scale and distortion 
increases with distance from the standard lines.

Figure 1.9 Pattern of distortion

Transverse Mercator Projection is a type of cylinder projection that result from 
projecting the sphere onto a cylinder secant around a central meridian (e.g. 
rotated 90 deg from equator). Transverse Mercator maps are often used to 
portray areas with larger north-south than east-west extent. Distortion of 
scale, distance, direction and area increases away from the central meridian.

Plane

Plane projections are projections to a plane placed tangent to the globe at a 
point. In normal (or polar) aspect, the point of tangency is either the north or 
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Basic Geodesy
south pole and meridians of longitude are represented as radial straight lines 
through the pole while parallels of latitude appear as concentric circles. 

Figure 1.10 Map projection: plane

Distortion in the map increases with distance from the point of tangency. 
Since distortion is minimal near the point of tangency, azimuthal projections 
are useful for representing areas having approximately equal extents in the 
north-south and east-west directions.

Figure 1.11 Pattern of distortion

1.5.2 Map characteristics

Map projections are attempts to portray the surface of the earth or a portion of 
the earth on a flat surface. Some distortions of conformality, distance, direc-
tion, scale, and area always result from this process. Some projections mini-
mize distortions in some of these properties at the expense of maximizing 
errors in others. Some projection are attempts to only moderately distort all of 
these properties.
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Map Projection
Conformality
When the scale of a map at any point on the map is the same in any direction, 
the projection is conformal. Meridians (lines of longitude) and parallels (lines 
of latitude) intersect at right angles. Shape is preserved locally on conformal 
maps (Transverse Mercator projections).

Distance
A map is equidistant when it portrays distances from the centre of the projec-
tion to any other place on the map.

Direction
A map preserves direction when azimuths (angles from a point on a line to 
another point) are portrayed correctly in all directions.

Scale
Scale is the relationship between a distance portrayed on a map and the 
same distance on the earth. 

Area
When a map portrays areas over the entire map so that all mapped areas 
have the same proportional relationship to the areas on the earth that they 
represent, the map is an equal-area map.

1.5.3 Mercator Projection

The projection can be thought of as being mathematically based on a cylinder 
tangent at the equator.

The use of the Mercator map projection as the base for nautical charts is uni-
versal. (Which does not mean that all nautical charts are based on the Merca-
tor projection, but most are)

The major navigational feature of the projection is found in the fact that a sail-
ing route between two points is shown as a straight line, if the direction or azi-
muth of the ship remains constant with respect to north. This kind of route is 
called a loxodrome, or rhumb line. Conversely, it is also true that any straight 
line depicts a rhumb line. This implies, that all angles maintain the sizes that 
they have on the surface of the globe.

Lines of longitude and latitude are both straight and parallel. The linear scale 
is not true, i.e. not isometric. Aerial distortion is extreme away from the equa-
tor. Shape is true only within any small area. 

1.5.4 Transverse Mercator Projection

Transverse Mercator projections result from projecting the sphere onto a cyl-
inder secant around a central meridian (longitude). Transverse Mercator 
maps are often used to portray areas with larger north-south than east-west 
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extent. The projection is not valid in polar regions. Distortion of scale, dis-
tance, direction and area increases away from the central meridian.

The Transverse Mercator projection is also called the Gauss-Kruger (or 
Gauss) projection in some parts of the world. Many national grid systems are 
based on the Transverse Mercator projection.

Universal Transverse Mercator (UTM)

A commonly used projection system is the Universal Transverse Mercator 
System (UTM). UTM coordinates are isometric coordinates referred to a spe-
cific UTM zone. There are 60 UTM zones, together covering all of the globe. 
However, UTM is not not defined north of 84° North and south of 80° South.

Figure 1.12 show the UTM zone numbers as distributed across the world. For 
example UTM Zone 32 extend from 6° East to 12° East and covers most of 
Denmark.

Figure 1.12 UTM Zone numbers

The relation between central meridian (CM) and primary UTM Zone is given 
below. CM is negative for western meridians and positive for eastern meridi-
ans.

Calculation of UTM Zone
Equation: Zone = (177 + CM)/6 + 1 

Example: Central Meridian 9° East equals zone 32:
Zone = (177 + 9)/6 + 1 = 31 + 1 = 32

Calculation of Central Meridian
Equation: CM = 6*(Zone - 1) - 177
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Example: Zone 33 has a Central Meridian of 15° East:
CM = 6*(33 - 1) - 177 = 192 - 177 = 15

Coordinates are not always referred to the primary UTM Zone. When an area 
spans several UTM zones, it may be more practical to refer all coordinates 
within an area to the same UTM zone. Therefore, it must always be ascer-
tained just what UTM zone coordinates refer to, and when UTM coordinates 
are passed on to someone else, they should be accompained by the proper 
UTM zone information.

1.6 Datum Transformation

1.6.1 Introduction

The process of converting coordinates from one datum to another datum is 
called a datum transformation. Some commonly used geodetic datums and 
their ellipsoids are shown in the following table 

Ideally, a single datum should be used in a country or region so that all data 
can be referenced to a common coordinate system. In practice it is never so: 
it is frequently necessary to deal with two or more datums (for example, a 
local datum for existing mapping and a newer geocentric datum for satellite 
navigation).

The latitude, longitude and height of a point defined on Datum 1 will be differ-
ent to its latitude, longitude and height defined on Datum 2 as a consequence 
of:

 the ellipsoids being different shapes

 the centres of the ellipsoids being displaced

 the Cartesian coordinate axes of the two datums not being parallel or 
being subject to a scale difference

Coordinates can be converted from one datum to another if the relationship 
between the two is known. The relationship is described by two components, 
being:

Table 1.1 Sample of geodetic datums and ellipsoids

Geodetic datum Ellipsoid

WGS 84 World Geodetic System of 1984 WGS84

NAD 27 North American Datum of 1927 Clarke Spheroid of 1866

OSGB36 Airy 1830
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1. a set of Formulae, which describes the mathematics of the transforma-
tion process

2. a set of Parameters, referred to as transformation parameters

1.6.2 Formulae

Two common transformation models are available for the conversion of 
parameters from one datum to another.

Molodensky transformation

The Molodensky transformation requires 3 parameters, see Equation (1.2) 
and Figure 1.13.

(1.2)

where 

X1, Y1, Z1 is the Cartesian Coordinates of Datum 1,
X2, Y2, Z2 is the Cartesian Coordinates of Datum 2 and
X, Y, Z is the difference between the centres of the two spheroids.

1 common point is adequate for the determination of the 3 parameters.

Figure 1.13 Molodensky transformation parameters. 

X1 X2 X+=

Y1 Y2 Y+=

Z1 Z2 Z+=
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3D Helmert transformation

The 3D Helmert Transformation requires 7 parameters, see Equation (1.3) 
and Figure 1.14.

(1.3)

where

X1, Y1, Z1 is the Cartesian Coordinates of Datum 1,
X2, Y2, Z2 is the Cartesian Coordinates of Datum 2, 
X, Y, Z is the difference between the centres of the two spheroids, 
RX, RY, RZ is the rotations around the three coordinate axes and 
Sc is the scale difference between the coordinate systems.

The sign convention of RX, RY and RZ is such that a positive rotation about an 
axis is defined as a clockwise rotation of the position vector when viewed 
from the origin of the Cartesian coordinate reference system in the positive 
direction of that axis.

3 common point are adequate for the determination of the 7 parameters.

Figure 1.14 3D Helmert Transformation

1.6.3 Parameters 

The transformation parameters which are substituted into the Formulae (i.e. 
X, Y, Z, RX, RY, RZ and Sc) identify the relationship between the particular 
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datums in question. They are calculated by comparing coordinate sets from 
the two datums. 

You may find examples of transformation parameters in the following link: 
http://www.arcwebservices.com/arcwebonline/services/dattrans.htm.

The transformation parameters are derived by analysing survey control sta-
tions which have coordinates on both datums. The minimum number of sta-
tions required for this process depends on the transformation method being 
proposed. However, there is no maximum limit, and in general, as many sta-
tions as possible are normally used. 

NOTE: Others may specify the R-parameters in a diffent way than DHI.

1.7 References

Further reading about geodesy and map projections in general can be found 
on the following web-sites:

http://www.posc.org/Epicentre.2_2/DataModel/Exampleso-
fUsage/eu_cs34.html

http://mathworld.wolfram.com/LambertConformalConicProjection.html
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Introduction
2 Geodesy in MIKE Zero

2.1 Introduction

All MIKE Zero products that work with spatial data relate the data elements to 
geographical positions on the planet earth. This is managed through the use 
of map projections. A map projection is basically a formula for converting 
between Cartesian (x,y)-coordinates - often in map projections referred to as 
easting and northing - and longitudes and latitudes. 

Most data files in MIKE Zero are tagged with:

 The map projection that the actual data is given in, and 

 The coordinates - expressed in the given map projection - of a reference 
point within the data. 

This makes it possible for MIKE Zero to calculate the exact geographical 
position of each point in a given data file.

MIKE Zero provides a comprehensive list of pre-defined map projections. 
However, there might be situations where you will need a projection not sup-
plied with the predefined projections available in the MIKE Zero installation. 
For these situations MIKE Zero provides a simple utility tool that allows you to 
create new map projections (see section 3.2 New Map Projection (p. 26)).

2.2 Definition of Map Projection

The map projections used in MIKE Zero must be defined in one of two type of 
format:

1. By specification in a DHI pfs-file, or

2. By using Open Standard GIS projection files

A collection of pre-defined map projections in both formats are included in the 
installation of MIKE Zero. 

2.2.1 DHI map projection

The pre-defined DHI map projections are specified by 5 files situated in the 
bin directory for MIKE Zero:

 one file containing the available ellipsoids (ellopsoid.pfs)
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 four files containing projection parameters for a number of map projec-
tions. The map projections are generally sorted in separate files accord-
ing to their datum:
- Miscellaneous (Map_projection.pfs)
- North American Datum 1927 (State_plane_nad27.pfs)
- North American Datum 1983 (State_plane_nad83.pfs)
- User defined (Custom_projection.pfs)

The latter file contains custum projections, e.g. map projections you can 
define yourself by giving a set of projection parameters. This is done from the 
menu item "Edit Map Projections" found in the MIKE Zero File menu under 
“Options”.

2.2.2 Open standard GIS projection

Included in the installation is a sample of the open standard GIS projection 
files, similar to those used in ESRI’s ArcGIS information system.

The files are self-extracted during the installation and installed in a directory 
within the DHI common files folder.

It is not possible to edit these files.

2.3 Selection of Map Projection

When specifying a map projection, just select from the drop down list in the 
different programs. The drop-down list will contain names of the latest 10 
map projections that has been used along with a browse facility that enables 
you to select from all the available map projections or to create a new map 
projection.

2.4 Grid Orientation

Model areas in MIKE Zero can (among others) be specified by a grid series 
file (dfs2), that is defined by the grid extension, map projection, geographical 
position of origin and grid orientation.

The grid orientation is defined as the angle between True North and the y-
axis of the grid measured clockwise. A mnemonic way of remembering this 
definition is by thinking of NYC, which normally means New York City, but 
which for our purpose means "from North to the Y-axis Clockwise", see 
Figure 2.1.
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Figure 2.1 Definition of grid orientation

When plotting a grid in the Plot Composer, you have the option to plot an Indi-
cation of Convergence. The convergence defines the angle between the lon-
gitude at the specific location and the northing line for the specific map 
projection. As such it is independent of the grid orientation.
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3 Map Projection Editing

You use the menu item "Edit Map Projections…" menu item in the MIKE Zero 
File menu under “Options” (see Figure 3.1).

Figure 3.1 MIKE Zero File pull-down menu

After you have selected the menu item, you will be presented with a dialog 
from where you can create a new map projection, delete or edit an existing 
one (see Figure 3.2). 

3.1 Map Projection Dialog

You use the map projection dialog to view, create, edit and delete map projec-
tions. The dialog is shown below in Figure 3.2.
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Figure 3.2 Map Projection Dialog

Note: All new map projections you create will be accessible in the map pro-
jection list under the “User Defined” group node.

3.2 New Map Projection

You define a new projection by specifying a set of map projection parameters, 
see Figure 3.3. 

Figure 3.3 New Map Projection dialog when selecting 
Lambert Conic Projection with 2 standard parallels.
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The number and type of parameters depends on the type of map projection. 

MIKE Zero presently understands the following types of map projections:

1. Albers equal area

2. Cassini-Soldner

3. Equidistant conic

4. Geographical

5. Hotine oblique mercator

6. Krovak oblique conformal conic

7. Lambert azimuthal equal area

8. Lambert conformal conic with 1 standard parallel

9. Lambert conformal conic with 2 standard parallels

10. Mercator with 1 standard parallel

11. Mercator with two standard parallels

12. New Zealand map grid

13. Oblique mercator

14. Polar stereographic

15. Rectified skew orthomorphic

16. Rotated longitude/latitude

17. Stereographic

18. Stereographic North Pole

19. Stereographic South Pole

20. Transverse Mercator (e.g. UTM)

Note: All new map projections you create will be saved in the file ‘cus-
tom_projection.pfs’ located in the local application data folder, e.g.
C:\Users\[User]\AppData\Local\DHI\MIKE Zero\[Year]
where [User] is the user identification name and [Year] the release year.

3.2.1 Albers equal area

For an Albers equal area projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The first and second parallel

 The central meridian

 The latitude origin
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 The false easting and northing

3.2.2 Cassini-Soldner

For a Cassini-Soldner projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The central meridian

 The latitude origin

 The false easting and northing

3.2.3 Equidistant conic

For a equidistant conic projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The first and second parallel

 The central meridian

 The latitude origin

 The false easting and northing

3.2.4 Geographical

For a Geographical projection you only need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

3.2.5 Hotine oblique mercator

For a Hotine oblique mercator projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The scale of the projection

 The longitude of the center of the projection

 The latitude of the center of the projection

 The Azimuth value

 The false easting and northing
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3.2.6 Krovak oblique conformal conic

For a Krovak oblique conformal conic projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The scale at pseudo parallel

 The pseudo parallel

 The longitude and latitude of the center of the projection

 The Azimuth

 The XY plane rotation

 The X and Y scale

 The false easting and northing

3.2.7 Lambert azimuthal equal area

For a Lambert azimuthal equal area projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The central meridian

 The latitude origin

 The false easting and northing

3.2.8 Lambert conformal conic with 1 standard parallel

For a Lambert conformal conic projection with 1 standard parallel you need to 
specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The scale of the projection

 The central meridian

 The latitude origin

 The false easting and northing

3.2.9 Lambert  conformal conic with 2 standard parallels

And for a Lambert conformal conic projection with 2 standard parallels you 
specify:
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 The name of your new projection

 The ellipsoid the projection is based upon

 The first and second parallel

 The longitude and latitude origin

 The false easting and northing

3.2.10 Mercator with 1 standard parallel

For a Mercator projection with one standard parallel you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The scale of the projection

 The central meridian

 The false easting and northing

3.2.11 Mercator with two standard parallels

For a Mercator projection with two standard parallels you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The first parallel

 The central meridian

 The false easting and northing

3.2.12 New Zealand map grid

For a New Zealand map grid projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The longitude origin

 The latitude origin

 The false easting and northing

3.2.13 Oblique mercator

For an Oblique mercator map projection you need to specify:

 The name of your new projection
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 The ellipsoid the projection is based upon

 The scale of the projection

 The longitude of the center of the projection

 The latitude of the center of the projection

 The Azimuth

 The false easting and northing

3.2.14 Polar stereographic

For a Polar stereographic map projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The scale of the projection

 The central meridian

 The latitude origin

 The false easting and northing

3.2.15 Rectified skew orthomorphic

For a Rectified skew orthomorphic map projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The scale of the projection

 The longitude of the center of the projection

 The latitude of the center of the projection

 The Azimuth

 The XY plane rotation

 The false easting and northing

3.2.16 Rotated longitude/latitude

For a Rotated longitude/latitude map projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The longitude of the south pole

 The latitude of the south pole
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 The angle of rotation

3.2.17 Stereographic

For a Stereographic projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The scale of the projection

 The central meridian 

 The latitude origin

 The false easting and northing

3.2.18 Stereographic North Pole

For a Stereographic North Pole projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The first parallel (per default set to 60 degrees)

 The central meridian

 The false easting and northing

3.2.19 Stereographic South Pole

For a Stereographic South Pole projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The first parallel (per default set to -60 degrees)

 The central meridian

 The false easting and northing

3.2.20 Transverse Mercator

For a Transverse Mercator map projection you need to specify:

 The name of your new projection

 The ellipsoid the projection is based upon

 The scale of the projection

 The central meridian
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 The latitude origin

 The false easting and northing

Note: This map projection type is the basis for the UTM projections.

3.3 Edit Map Projection

You use the Edit Map Projection dialog to redefine the map projection param-
eters defining the projection. The dialog is shown in Figure 3.4.

Figure 3.4 Edit Map Projection dialog when selecting Transverse Mercator

Usually the pre-defined projections that are installed along with the MIKE 
Zero are write-protected and cannot be edited.

Note: The number of parameters you can modify in an existing projection 
depends on the projection itself.

3.4 Find Map Projection

You may find a pre-defined map projection from the list by searching a text 
string that is a part of the map projection name. The dialog is shown in 
Figure 3.5.
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Figure 3.5 Find Map Projection dialog

3.5 Ellipsoids

You use the ellipsoid dialog to view, create, edit and delete ellipsoids. 
The dialog is shown below in Figure 3.6.

Figure 3.6 Browse Ellipsoids dialog

This functionality is typically only used in connection with creating a New Map 
Projection when the existing ellipsoids are not applicable.

Note: All new ellipsoids you create will be accessible in the ellipsoid list under 
the “User Defined” group node.

3.5.1 New ellipsoid

You define a new Ellipsoid by specifying a name along with the values for 
semi-major axis and inverse flatness, see Figure 3.7.
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Figure 3.7 New ellipsoid dialog

Note: All new ellipsoids you create will be saved in the file ‘custom_ellip-
soid.pfs’ located in the local application data folder, e.g.
C:\Users\[User]\AppData\Local\DHI\MIKE Zero\[Year]
where [User] is the user identification name and [Year] the release year.

3.5.2 Edit ellipsoid

You use the Edit Ellipsoid dialog to redefine the ellipsoid parameters defining 
the ellipsoid.

Usually the pre-defined ellipsoids that are installed along with the MIKE Zero 
are write-protected and cannot be edited.
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4 Datum Conversion Utility

You use the menu item "Datum Convert…" menu item in the MIKE Zero File 
menu (see Figure 4.1).

Figure 4.1 MIKE Zero File pull-down menu

After you have selected the menu item, you will be presented with a dialog 
from where you can convert xyz data between different coordinate systems 
(see Figure 4.2).

4.1 Datum Conversion

The Datum Conversion utility is a tool for converting spatial data coordinates 
from one coordinate system to another. This can be between two different 
projected coordinate systems, from projected data to geographical data (or 
vice/versa), and with or without datum transformation.

A log containing the session history keeps track of the conversions for the 
active data set.

You may save the conversion parameters in a conversion template for future 
use.

The dialog is shown below in Figure 4.2.
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Figure 4.2 Datum Conversion dialog

4.1.1 Batch execution

You can convert spatial data without using the dialogs attached by executing 
the program by a batch command from a DOS-prompt.

The syntax for executing the program is:

DatumConvert inputfile.xyz -template template.cvt [-dms2dd] [-a2b] [-
b2a] [-dd2dms] [-save] [-save_as outputfile.xyz] 

A template must be created beforehand to define the Datum properties for 
the two coordinate systems. How to create a template for Datum Conversion 
is described in section 4.6.4 Conversion Template (p. 43).

You specify -a2b or -b2a to define if the conversion is from Coordinate Sys-
tem A to Coordinate System B, or vice versa, respectively.

You specify -dms2dd or -dd2dms to enable a conversion from degrees, min-
utes and seconds to decimal degrees, or vice versa, respectively.

You specify -save if the output is to be saved in the input file. Otherwise you 
specify -save_as and an output file name.
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4.2 Spatial Data

The Datum Conversion utility converts spatial XYZ data, shown in the spread-
sheet to the right in the dialog, according to the definitions of coordinate sys-
tem A and B, respectively. Note that you need to specify the applied units for 
the data.

You can add the spatial data to the dialog in two ways:

 By manual input in the spreadsheet to the right
(press Enter in the lower right Text cell to add new line)

 By opening an ascii-file containing rows with spatial coordinates (and 
maybe text) organised in columns (Select File->Open).

NOTE: In an ascii-file the first three columns must be numeric data. All char-
acters in the line after the third column are regarded as text and inserted in 
the last column in the speadsheet, including spaces. Please see 4.6.6 
Options (p. 44) for how to interprete the value in the third column in an ascii 
file.

You can export the data in the spreadsheet to an ascii-file at any time by 
selecting File->Save or File->Save as.

Per default the program search for ascii-files with extension .xyz, but it is pos-
sible to apply other extensions.

4.2.1 Vertical dimension

The spatial data is defined by a geodetic height (height above ellipsoid) or a 
Z-value (height above datum level). During the data conversion both height 
and Z-value may change if the coordinate systems utilize different ellipsoids.

Figure 4.3 Definition of Z and height value in spatial data
Note: at open waters the geoide can be interpreted as the mean sea 
level

Please see 4.6.6 Options (p. 44) for how to interprete the value in the third 
column.
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4.3 Coordinate System

When converting XYZ data you need to specify the properties for the coordi-
nate system that the data is defined by now AND the properties for the coor-
dinate system by which you want to define your data after the conversion. 

A coordinate system used for the conversion is defined by a Map projection, 
the Type of coordinates and Datum shift.

4.3.1 Map projection

You must specify the map projection of the data. You can select from a wide 
assortment of map projections installed with MIKE Zero.

4.3.2 Type of coordinates

You must specify the type of coordinates. The XYZ data can be displayed in 
two ways:

 Cartesian coordinates (Map projection, meters)

 Geodetic coordinates (Geographical, longitude/latitude)

The definition of cartesian and geodetic coordinates, respectively, is shown in 
Figure 4.4.

Figure 4.4 Geodetic coordinates versus Cartesian coordinates
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4.3.3 Datum shift

If you want to simply translate spatial coordinates between a map projection 
and corresponding geographical coordinates, keeping the same datum, you 
specify ‘none’ for Datum shift.

If you want to add a datum shift to the map projection already defined you 
must specify some datum transformation parameters. The parameters are as 
follows:

 dx, dy, dz 
The difference between the centres of the two spheroids

 Rx, Ry, Rz 
The rotations around the three coordinate axes)

 Sc (scale difference between the coordinate systems)

NOTE: In general the datum parameters are sign reversible. The Datum Con-
verter use the Markus convention for rotation parameters. This may be of 
opposite sign compared to other sign conventions.

Additional description of how the parameters are defined and how the datum 
shift is calculated can be found in Datum Transformation (p. 17) and below. 

4.4 Datum Transformation Process

The sequence in converting coordinates from Datum ‘1’ to Datum ‘3’ is given 
below and illustrated in Figure 4.5 (Datum ‘2’ denotes the reference datum, 
handled internally by the program).

1. Transformation of map grid coordinates (eg. UTM) on Datum '1' to geo-
detic coordinates on Datum '1’.

2. Conversion of the geodetic coordinates on Datum '1' to XYZ Cartesian 
values on Datum '1’. 

3. Conversion of the XYZ Cartesian values on Datum '1' to XYZ Cartesian 
values on Datum '2' or '3'. 

4. Convert the XYZ Cartesian values on Datum '2' or '3' to geodetic coordi-
nates on Datum '2' or '3'. 

5. Convert the geodetic coordinates on Datum '2' or '3' to map grid coordi-
nates on Datum '2' or '3'. 
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Figure 4.5 Datum transformation process

4.5 Session History

After each conversion of xyz data, the program writes the conversion param-
eters in the Session History log window located down left in the dialog. This 
enables you to keep track of the conversions taken place after the initial input 
of XYZ data into the spreadsheet.

4.6 Tools

A number of utilities can be accessed through the Tools menu in the top 
menubar.

Figure 4.6 Available tools
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4.6.1 Conversion between A and B

Converts data between coordinate system A and coordinate system B. Holds 
the same functionality as pressing the ‘Convert from...’ buttons.

4.6.2 Conversion between DD and DMS

Geographical coordinate values may be expressed by decimal degrees (DD) 
or degrees, minutes and seconds (DMS).

The definition of a coordinate in DMS is deg.mmss where the value in front of 
the digit is degrees (deg) and the values behind the digit is minutes (mm) and 
seconds (ss), respectively.

The relation between DD and DMS is as follows:

DD = deg + (mm . 60 + ss)/3600

4.6.3 Convergence of A or B to Text-column

The convergence defines the angle between the longitude at the specific 
location and the northing line for the specific map projection.

You can calculate the convergence angle for each coordinate point. The con-
vergence angle will be written to the text column in the display (the last col-
umn).

Note: Any existing data in the text column will be overwritten.

4.6.4 Conversion Template

If you are frequently going to convert data from coordinate system A to coor-
dinate system B, it can be time saving to save the conversion parameters in a 
Conversion Template (extension .cvt) that can be opened and re-applied on a 
new data set.

As an example Qatar_WGS84.cvt is shown in Figure 4.7. This file defines the 
entire transformation.
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Figure 4.7 Template content displayed in NotePad.
Coordinate system A: Qatar National Grid + datum shift
Coordinate system B: WGS 84 UTM Zone 39N.

4.6.5 Set height to zero

When the applied coordinate systems utilize different ellipsoids the height 
may be converted to a value besides 0. This value may affect the outcome of 
further conversions. 

This functionality holds the opportunity to reset the height value to 0. 

4.6.6 Options

The spatial data values may be listed by columns in an ascii file. You have the 
opportunity to define how the Vertical dimension in the third variable is to be 
interpreted during reading or writing the data.

Figure 4.8 Options for reading and writing ascii data file
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5 Using the Geodesy in MIKE Zero

This chapter shows how to apply the mapping functions included with MIKE 
Zero.

5.1 New bathymetry based on two different map projections

5.1.1 Introduction

The example demonstrates how to establish a bathymetry for the Bay of Kirk-
wall at the Orkney Islands using OSGB as map projection. The bathymetry is 
created using the Bathymetry Editor and saved as a dfs2 data file.

In order to create the bathymetry, depth contours have been extracted from 
MIKE C-MAP. The extracted data is given in geographical coordinates based 
on the WGS84 ellipsoid. 

When specifying a map projection, just select from the drop down list in the 
given dialog or browse to the desired projection. Sometimes the data to 
import is not in the same map projection as the working area, however the 
program includes automatic conversion of the data.

Note: The automatic conversion of data does not consider datum shift.

Figure 5.1 Sea chart showing Bay of Kirkwall
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5.1.2 Defining working map projection

The area of interest is shown in Figure 5.1. The approximately coordinates 
covering the area (expressed in OSGB) are as follows:

 Easting 344200 

 Northing 1010800 

 Area width of 3000m 

 Area height of 2600m

The MIKE Zero Bathymetry Editor is started and the working area defined 
accordingly. Please note, that the map projection has been defined as OSGB. 

The map projection for the working area is defined as shown in Figure 5.2. 

Figure 5.2 Defining map projection for the working area

After pressing OK on the working area definition dialog the working area is as 
presented in Figure 5.3.
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Figure 5.3 Working area in OSGB

5.1.3 Importing geographical points

It is now possible to the land and water values extracted from MIKE C-Map. 
From the "Work Area" menu "Background Management" is selected and then 
"Import xyz files". 

Hereafter the files 'water.xyz' and 'land.xyz' is selected. The data is given in 
geographical coordinates based on the WGS84 ellipsoid. Thus, in the "Con-
vert from" box the map projection is selected as LONG/LAT. The data will - 
after clicking "Open"- be converted from LONG/LAT to OSGB automatically. 
This is illustrated in Figure 5.4.

After importing both 'water.xyz' and 'land.xyz', the working area will look as 
shown in Figure 5.5. Note that the imported XYZ data is converted and 
shown in the OSGB map projection.
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Figure 5.4 Importing xyz-files from Longitude, Latitude in WGS84

Figure 5.5 After import of land and water from MIKE C-MAP in Long/Lat WGS84
48 MIKE Zero Geodesy - © DHI A/S



New bathymetry based on two different map projections
The example comes with additional data files. These are already in OSGB 
and shall therefore not be converted during import, i.e. the option "No conver-
sion" is selected in the "Open" dialog. After importing all data the working 
area looks like the one presented in Figure 5.6.

The points are used for generation of the bathymetry. The interpolated 
bathymetry is always generated based on the working area map projection, 
e.g. OSGB in this example.

A plot (generated by MIKE Animator) of the bathymetry is shown in 
Figure 5.7.

Figure 5.6 Working Area after importing xyz-files from OSGB
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Figure 5.7 Coarse unfiltered grid bathymetry

5.2 Converting spatial data

You can use the Datum Convert utility for both simple conversion and more 
complicated transformations.

The files used in the following examples are positioned in the DatumConvert 
example directory at (default installation):
.\Examples\MIKE_Zero\DatumConvert

5.2.1 Simple conversion

Assume that you have some spatial data given in the map projection UTM-33 
and you want to translate the data so your coordinates are given in longitude-
latitude for the same ellipsoid.

To convert the data do the following:

1. Open Datum Convert utility

2. Use File->Open and select the file positions.xyz 

3. Define Coordinate system A as UTM-33, Map Projection coordinates

4. Define Coordinate system B as UTM-33, Geographical coordinates (the 
dialog should now resemble Figure 5.8).

5. Press button ‘Convert from A to B’.

6. This converts the data and you will see the coordinates as longitude/lati-
tude in the spreadsheet as shown in Figure 5.9.
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7. Use File->Save As to save the data under a new filename.

Figure 5.8 Datum Convert dialog before conversion of data.
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Figure 5.9 Datum Convert dialog after conversion of data.

5.2.2 Conversion with Datum shift 

Assume that you have some spatial data coordinates in Map Projection 
WGS_1984_UTM_Zone_39N and you want to convert these to a National 
grid, namely Qatar National Grid. This map projection grid use the ellipsoid 
International 1924, different from the WGS 1984 ellipsoid. 

To convert these data it is necessary to include Datum Shift for the conver-
sion. The datum shift parameters for the Qatar National Grid are as follows:

X = -119.4248 [m],
Y = -303.65872 [m],
Z = -11.00061 [m],
RX = 1.164298 [arcsec],
RY = 0.174458 [arcsec],
RZ = 1.096259 [arcsec],
Scale = 3.657065 [ppm]

To convert the data do the following:

1. Open Datum Convert utility

2. Use File->Open and select the file QatarPoints.txt 
(this file is positioned at .\Examples\MIKE_Zero\DatumConvert)
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3. Define Coordinate system A as WGS_1984_UTM_Zone_39N, Map Pro-
jection coordinates.

4. Define Coordinate system B as Qatar National Grid, Map Projection 
coordinates and the Datum shift parameters listed above.

5. Press button ‘Convert from A to B’.

6. This converts the data and you will see the coordinates as Qatar National 
Grid coordinates in the spreadsheet as shown in Figure 5.10.

7. Use File->Save As to save the data under a new filename.

Figure 5.10 Converted data from WGS 1984 UTM Zone 39 N to Qatar National Grid

5.2.3 Datum Conversion in Batch

Consider the Qatar data given in the previous example. You can convert 
these data by a batch command. 

A conversion template has already been created (Qatar_WGS84.cvt):
- Coordinate System A defines the Qatar National Grid including the Datum 
shift parameters.
- Coordinate System B defines WGS 84 UTM Zone 39N.

To convert the data in batch mode do the following:
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1. Open a DOS-prompt in the DatumConvert example directory

2. Execute the following command:
DatumConvert QatarPoints.txt -template Qatar_WGS84.cvt -b2a -
save_as QatarPoints_New.xyz

The coordinate points given in the output file are the same as the data shown 
in Figure 5.10. 
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